Crystal Reports
Troubleshooting Report Designer Component Application Issues

Overview
This document gives a step-by-step guide to run the Report Designer
Component (RDC) SDK sample application on Crystal Reports 10,
Crystal Reports XI, or Crystal Reports XI Release 2.
It also provides basic troubleshooting techniques for the RDC
application, some important links to samples and articles relevant to
RDC. This document is a good starting point for those new to the RDC.
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Introduction
The Report Designer Component or RDC allows developers to integrate
report editing and viewing into their application. RDC can be used to
open, design, customize, and view reports both programmatically using
RDC SDK and with the built in user interface.
This paper focuses on using RDC only within applications. RDC can be
integrated with applications developed with Visual Basic, Visual C++, or
classic ASP. This paper is primarily aimed at classic ASP or Visual Basic
Developers.
We will first discuss how to get the RDC samples to work on the Crystal
installation, and then we will discuss some troubleshooting techniques
that are specific to customer’s reports and application.

Running the Sample RDC Application
The simplest way to integrate pre-designed reports into a web
application using RDC is to use the RDC ASP samples available for
Crystal Reports 10, Crystal Reports XI, and Crystal Reports XI Release 2.
The sample application is supplied with sample reports to be viewed.
With minimal changes to the sample, custom reports can be viewed
instead of only the sample reports.
Here is a step-by-step guide to getting the sample RDC application to
run on the Crystal Installation. It is assumed that the reader is familiar
with basic functions of Internet Information Services (IIS) Manager such
as restarting IIS service, mapping a virtual directory, and launching an
ASP application.

Open the RDC samples
Determine the exact version of Crystal Reports being used. Use RDC
samples specific to the version of Crystal Reports. Here are the links to
samples for different versions of Crystal Reports.
Crystal Reports 10:
http://support.businessobjects.com/communityCS/FilesAndUpdat
es/aspxmps10.exe.asp
Crystal Reports XI:
http://support.businessobjects.com/communityCS/FilesAndUpdat
es/aspxmps11.exe.asp
Crystal Reports XIR2:
http://support.businessobjects.com/communityCS/FilesAndUpdat
es/aspxmps115.zip.asp
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Download and run the self-extracting executable. One of the following
folders will be created:
•

aspmps10 if using Crystal Reports 10 samples

•

aspmps11 if using Crystal Reports XI samples

•

aspmps115 if using Crystal Reports XIR2 samples.

This folder contains a collection of report viewing samples using the
RDC SDK. The samples are organized into different folders within the
root folder. BeginHere is the sample which shows simple report viewing
with the ActiveX viewer.
Copy and paste the BeginHere folder to …inetpub\wwwroot.
Alternately, create a virtual directory in the IIS manager pointing to the
BeginHere folder.

Run the BeginHere sample
Locate SimplePreviewReport.asp in IIS Manager in the BeginHere
application.
Right-click it. Click Browse. This starts a new browser. Run the
BeginHere sample. Alternately, if browsing ASP is not enabled for the
application in IIS, use a URL similar to following:
http://<server name, ip or localhost>/<BeginHere or directory structure
on IIS>/SimplePreviewReport.asp
If successful, it will prompt to download an ActiveX appears in the
information bar at the top of the browser page if one does not reside on
the computer already.
After installing the ActiveX control, it displays the report in the ActiveX
viewer in the browser window.

Troubleshooting the BeginHere sample
If not successful, use the any or all of the following topics for basic
troubleshooting.
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Browser issues
If using Firefox or another browser, try using Internet Explorer instead.

Not prompted for ActiveX
If not prompted to install the ActiveX control, go to the IIS Manager.
From that location, ensure the following virtual directory exists in IIS in
the same site as BeginHere:
•

Crystalreportviewers10 for Crystal Reports 10

•

Crystalreportviewers11 for Crystal Reports XI

•

Crystalreportviewers115 for Crystal Reports XI Release 2.

Its local path should point to the respective directory in the Crystal
Reports or BusinessObjects installation.
If IIS was installed on the server prior to installing Crystal Reports or
BusinessObjects, then this directory should be already configured.
If the directory is missing, then create one using the exact same name as
above. Link it with the directory of the same name in the Crystal Reports
or Business Objects installation. Run the sample again.

Using the Java viewer instead of ActiveX
Try using the Java viewer instead of ActiveX viewer.
Open SimplePreviewReport.asp on the server for editing. On the last
line include file JavaPluginViewer.asp instead of
SmartViewerAcxtiveX.asp to use Java Viewer to view the report. A JRE
is required on the computer from the application is started.
If the Java viewer works correctly, check if the security settings have
issues with installing ActiveX viewer.

Verify the correct version of ActiveX
Change the code to again use ActiveX viewer. Run the sample directly
on server and a client machine and see which one works.
If it fails only on a client computer, then there are chances that the
security settings don’t allow installing ActiveX control, it has become
corrupted, or is running a different version.
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Check if there is any ActiveX control listed in Tools > Internet Options >
Settings > View Objects. Controls from Crystal Reports 8 or 9 may exist if
an application was using an older version of Crystal previously on the
client computer.
To ensure that the appropriate version of ActiveX control is being used,
use the following URLs:
•

http://<servername, IP, or
localhost>/Crystalreportviewers10/ActiveXControls/
ActiveXViewer.cab for Crystal Reports 10

•

http://<servername, IP, or
localhost>/Crystalreportviewers11/ActiveXControls/
ActiveXViewer.cab for Crystal Reports XI

•

http://<server name, IP, or
localhost>/Crystalreportviewers115/ActiveXControls/
ActiveXViewer.cab for Crystal Reports XI Release 2.

A prompt appears to save a ZIP file on the computer containing the
ActiveX control.
Save and extract the ZIP file. It contains crviewer.inf. Right-click
crviewer.inf > click Install.
The ActiveX control is installed on the computer. Attempt to start the
application again.

For more information on installing ActiveX control manually on client
computers, refer to Knowledge Base article c2017441.

NOTE

At this point, the ActiveX control is installed properly on the computer
and BeginHere works.

Other possible reasons
If not, however, there may be other factors.
•

Older registry components may still exist if the application has been
upgraded from an earlier version.

•

A side-by-side installation of two different versions of Crystal
Reports can cause this behavior.

•

The specific IIS configuration can be faulty.

•

The Crystal Reports build version can also be lacking.

Use the methods below to determine the root cause of issue and how to
resolve it.
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Use Filemon
Download and install the Filemon utility from the Microsoft TechNet
site. Filemon monitors all the file related activities on the computer.
Run Filemon and the RDC asp sample concurrently.
Check the Filemon log for Crystal and RDC specific entries. The
keywords for which to search are:
•

Crystal

•

craxdrt.dll

•

access denied.

If any right access or permission issues are seen, then run the RDC as a
COM+ application.

NOTE

Another utility that monitors registry can also be useful. It can be downloaded from:

http://www.microsoft.com/technet/sysinternals/processesandthread
s/regmon.mspx

Running the RDC as a COM+ application
CRAXDRT.dll installed in the BusinessObjects or Crystal installation is
the RDC component. It runs with IUSER credentials on the system by
default. Sometimes it lacks the necessary privileges to access different
services offered by underlying operating system such as file access or
database access. To overcome any such issues it is recommended to run
RDC as a COM+ application. Run the COM+ application with
administrative credentials on the system and ensure that RDC is getting
all the required access.
A detailed description and guide demonstrating how to run RDC in a
COM+ application can be found in Knowledge Base article c2018861.
Permission issues can occur when setting database logon information for
report in the code or when connecting to database to pull up new data in
report as opposed to viewing report with saved data when it doesn’t
need to connect to the database. Running RDC in COM+ application will
resolve any right access issues faced in such scenario.
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Running the RDC outside of IIS
If the application is still facing issues even when running RDC as COM+
it is recommended to run RDC outside the realm of IIS to rule out any
issues within IIS causing the application to fail.
Copy and paste the code below to a file called test.wsf. Save it to the
desktop. WSF stands for Windows Script File.

test.wsf
-----------------------------------------------------------------------------------<job id='CSVCommandLineScheduler'>
<script language='VBScript'>

Option Explicit

Dim oApp
Set oApp = CreateObject("CrystalRuntime.Application")

Dim oRpt
Set oRpt =
oApp.OpenReport("c:\SimplePreviewReport.rpt",1)

Dim FileSystemObject
Dim FolderPath
Dim FolderObject
Set FileSystemObject
CreateObject("Scripting.FileSystemObject")
FolderPath = "c:\CrystalTest"
Set FolderObject =
FileSystemObject.CreateFolder(CStr(FolderPath))

Dim ExportOptions
Set ExportOptions = oRpt.ExportOptions
ExportOptions.FormatType = 29
ExportOptions.DestinationType = 1
ExportOptions.DiskFileName =
"\resultFile.xls"

FolderPath &

oRpt.Export False
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</script>
</job>
------------------------------------------------------

To run the code
1. Open the sample report saved directly under the C: directory.
Alternately, change the line “set oRpt = oApp.OpenReport
("c:\SimplePreviewReport.rpt",1)” to contain the right report path.
2. Double-click test.wsf. Upon successful execution it will create a
directory called CrystalTest in C: and save the exported report in
CrystalTest as result File.xls. This will confirm that RDC is running
properly.

The RDC prompts for report parameters and database logon only on
the server side. Therefore, all such information must be specified
programmatically.

NOTE

Running wsf reveals any errors because the prompts for required
information will appear.
If there are issues printing or exporting the report from the ActiveX
viewer, this will reveal any issues related to prompts for setting export
or print properties.
It may be necessary to install latest service pack on the Crystal
installation to resolve the issue.
If it is already known that the Crystal installation is not stable, or if one
or more DLLs are missing or not registered, then it is recommended to
reinstall Crystal Reports.

Troubleshooting Issues Specific to a Customer’s Application
Running the sample application ensures that RDC is working properly.
If a custom application or reports are still not working, use the following
troubleshooting methods:

Use the correct version of the rdcrptserver ASP file
Make sure that the correct version of rdcrptserver ASP file in the
application is used.
The correct versions are as follows:
•

rdcrptserver10.asp for Crystal Reports 10

•

rdcrptserver11.asp for Crystal Reports XI

•

rdcrptserver115.asp for Crystal Reports XI Release 2.
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Also, do not modify the following files while using them:
•

AlwaysRequiredSteps.asp

•

MoreRequiredSteps.asp

•

Cleanup.asp

•

JavaPluginViewer.asp

•

SmartViewerActiveX.asp.

Verify report parameters are provided correctly
Make sure that report parameter values for main report and all
subreports are provided programmatically. Refer to sample
“SimpleParameterField” for more information on how to set report
parameters.

View the report with saved data
If errors messages such as “Error reading records” are returned from
MoreRequiredSteps.asp, then there are issues connecting to the
database from RDC application.
Try viewing the report with saved data first. To save a report with data,
open it in Crystal Reports, preview it. Click File > Save data with report.
Save the report, and use it in application.

Ensure the code contains the proper logon information
Make sure that the required database logon information for main report
and all subreports is supplied in the code. Use the following link for a
quick reference to common database connection properties that must be
specified for different types of database connections:
http://devlibrary.businessobjects.com/BusinessObjectsXIR2/en/en/RD
C_SDK/rdc_com_dg_doc/doc/rdcsdk_com_doc/RDC_ObjectModel27.
html#1729115
Refer to samples SimpleSetLogonInfo and SubreportLogonExample for
information on how to set database logon for report.
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Open the report in different applications
Preview and refresh the report in Crystal report Designer and make sure
that it works.
If the report was designed in an older version of Crystal then try opening
the report from latest version of Crystal available. Run and save the
report from Crystal. Then use it in the RDC application.
It may be necessary to install the latest service pack on the Crystal
installation. Information on latest service packs can be found at:
http://support.businessobjects.com/downloads/default.asp
Specifically use sample SimpleExportIIS6IsolationMode when running
IIS6.

Windows Server 2003 vs. Windows 200
Typically an RDC application faces more issues on Windows Server 2003
than it faces on Windows 2000. Also, it runs differently on IIS6 than on
IIS5. Certain security setting such as machine’s DEP settings can affect
execution of RDC application.

Conclusion
The basic troubleshooting techniques discussed above should help
getting the RDC sample applications to run in most cases. Also, it is
possible to modify the sample code in order to run custom reports. Refer
to the ReadMe file in each sample for specific instructions.
This document should be sufficient for most of the issues although if
further assistance is needed, please visit the Business Objects Support
site, forums, or contact the Business Objects Customer Assurance Team.
A note of caution is that RDC is a deprecated technology. It will not be
supported with any Crystal product released after XI Release 2.
For upward compatibility consider Crystal Reports .NET SDK or
Business Objects Enterprise .NET SDK which will be available in future
product releases. Also consider using JRC and other Java SDKs.
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Finding More Information
Crystal Reports XI Report Designer Component SDK Documentation

http://www.techsupport.businessobjects.com/infocenter/dev/devl
ib/xi/en/en/RDC_SDK/default.htm
Crystal Reports
Documentation

XI

R2

Report

Designer

Component

SDK

http://devlibrary.businessobjects.com/BusinessObjectsXIR2/en/en
/RDC_SDK/default.htm
For more information and resources, refer to the product
documentation and visit the support area of the web site at
http://www.businessobjects.com/
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